# Table of Contents

**DOCUMENTATION CONVENTIONS** .......................................................... 2

**Section 1: System Description** .............................................................. 4
  - Function and Theory ........................................................................... 4
  - System Components .......................................................................... 5
  - Borescope Probe & Cable .................................................................. 5
  - Optional Reel ................................................................................... 6
  - Camera Control Unit ......................................................................... 7
  - Probe Centering Device ..................................................................... 8

**Section 2: System Software, AquaLITE** .................................................... 9
  - Downloading Latest Software Package .............................................. 10
  - AquaLITE Software Installation ....................................................... 10
  - Uninstall AquaLITE ......................................................................... 13
  - USB Driver Installation .................................................................... 16
  - Video Driver Installation ................................................................ 17
  - General Layout of Screen ................................................................. 17

**Section 3: System Check, Installation & Deployment** ............................... 25
  - System Hook-Up, Operational Check, & Data Collection Tests ............ 25
  - Installation & Preparation for Field Measurements ............................ 30
  - System Deployment & Data Interpretation ....................................... 31

**Section 4: System Maintenance & Calibration** ......................................... 32
  - Regular Maintenance ....................................................................... 32

**Section 5: System Troubleshooting & FAQs** .......................................... 34

**Section 6: System Specifications** ............................................................. 40
  - Borescope Specifications .................................................................. 40
  - Borescope Specification Notes ......................................................... 41
  - AquaLITE Software Requirements .................................................... 41

**Section 7: Parts and Accessories** ............................................................ 42

**Appendix A: Filtering AquaLITE Data for further Analysis** ....................... 44

**The Warranty** ....................................................................................... 49
DOCUMENTATION CONVENTIONS

This document uses the following conventions to present information:

An exclamation point icon indicates a **WARNING** of a situation or condition that could lead to personal injury or death. You should not proceed until you read and thoroughly understand the **WARNING** message.

A raised hand icon indicates **CAUTION** information that relates to a situation or condition that could lead to equipment malfunction or damage. You should not proceed until you read and thoroughly understand the **CAUTION** message.

A note icon indicates **NOTE** information. Notes provide additional or supplementary information about an activity or concept.
In order to ensure your Colloidal Borescope System has a long service life and operates properly, adhere to the following cautions and read this manual before use.

- Disconnect from power source when not in use.
- Power input source must not exceed maximum ratings.
- Equipment must be wired to a negative ground system.
- Equipment may not operate properly with excess wiring not supplied by manufacturer.
- Avoid spraying fluid directly at equipment.
- Never submerge equipment.
- Avoid pulling on wires to unplug equipment wiring.
- Avoid using equipment with obvious physical damage.
- To prevent equipment damage, avoid dropping it.

The Colloidal Borescope cannot be made dangerous or unsafe because of failure due to EMC interference.

WARNING

Do not operate this equipment if it has visible signs of significant physical damage other than normal wear and tear.

Notice for consumers in Europe:

This symbol indicates that this product is to be collected separately.

The following applies only to users in European countries:

- This product is designated for separate collection at an appropriate collection point. Do not dispose of as household waste.
- For more information, contact the seller or the local authorities in charge of waste management.
Section 1: System Description

Function and Theory

There are naturally occurring particles, colloids, in groundwater that are neutrally buoyant. These colloidal particles being carried by the natural groundwater can be observed and measured to obtain groundwater velocity and direction.

The Colloidal Borescope System integrates a high-resolution magnetic resistance compass, a high magnification particle imaging camera, and accurate tracking software, AquaLITE, to identify and measure groundwater velocity and particle flow trajectory.

The Borescope provides a magnified image of moving colloidal particles suspended in the borehole; these particles are tracked against magnetic heading information and efficiently provide velocity and trajectory of the colloidal particles. The Borescope’s compass is calibrated to true North and provides relative data regardless of the probe’s down well heading. Therefore, no data adjustments are required from site analysis.

Accidental spills and leaks associated with various facility operations have resulted in significant sub-surface contamination. The Colloidal Borescope offers an accurate methodology for assessing contaminant transport potential. Data acquired with the instrument may be used to quantify heterogeneities and dispersion – parameters necessary to estimate the extent and magnitude of underlying contaminants, define exposure routes, and assess risks.

Figure 1-1: Colloidal Borescope Probe Features
System Components

The Borescope Probe (Figure 1-3) encases the camera and compass and transmits a live video feed to the AquaLITE software. The software tracks colloidal particles passing through the field of view, located midway between the camera lens and red backlight. The camera housing and backlight head are constructed of stainless steel, and are sealed for underwater use to 1000' (305 m) depths.

Definition – Azimuth (noun): The Borescope probe’s magnetic heading in well. The software will use this information to provide velocity and trajectory data relative to true North, regardless of probe orientation.
Optional Reel

Systems with long lengths of cable may be equipped with a reel for ease of transport and deployment. Large reels have a convenient cable port mounted to the reel hub.

Figure 1-3: Detail, Borescope Probe in well with slotted screen
Camera Control Unit

The Camera Control Unit (CCU, Figure 1-4) manages the information transfer from the down well Borescope to the AquaLITE software live video feed. All components in the system connect to this box. The CCU has an ON/OFF switch and corresponding green “ON” light, as well as an adjustment knob for probe backlight brightness.

Laptop

The Borescope system requires a customer supplied laptop; the laptop must have an Express Card Slot to accommodate the PC video card shipped with the system. The video card is a VCE Express Card (~54mm wide).

Software

The AquaLITE software provided with the system is installed and operated as outlined in the next section.

When you receive the Colloidal Borescope, unpack it carefully and inspect for any shipping damage. Please contact Geotech Environmental Equipment if any damage is noted.
Probe Centering Device

If deploying the Borescope probe into a 4” (10 cm) well, Geotech recommends the Borescope be equipped with centering disks. The disks will help stabilize the Borescope within the larger diameter well, and can help guide colloidal flow into the camera’s field of view.

A full centering device kit consists of
- 4 flow restrictor clamps
- 2 centering rings
- 8 setscrews

The centering rings are held in between the restrictor clamps. The restrictor clamps are secured to the probe with setscrews.

Before deploying the Probe with Centering Devices, ensure the clamp assemblies are tight by gently tugging with your hand.

Figure 1-5: Probe Centering Device
Section 2: System Software, AquaLITE

The AquaLITE software included in the Colloidal Borescope system is a key component in obtaining a reliable flow measurement. Typically, there are two types of measurements that can be encountered in a well; if consistent horizontal flow in a steady direction for two or more hours occurs then the Borescope is in a preferential flow zone where groundwater flow is occurring. If the colloids remain in focus across at least one-half of the field of view, then horizontal flow conditions dominate the measurement zone. If variable flow conditions persist, then the instrument should be moved to a different depth. Experience has shown that if swirling flow conditions persist after 15 to 20 minutes, especially if the Borescope has been in the well at other test intervals, then a non-preferential flow zone has been encountered and the instrument should be moved to a new test interval.

When the Colloidal Borescope is inserted into the well, the ambient groundwater flow is disturbed. The Borescope acts as a slug that can cause water from the well bore to flow into the surrounding aquifer and affect flow measurements. These effects commonly last 10 to 30 minutes before ambient flow conditions re-establish in the well bore. Use the graph view in the tracking software to view the consistency of the directional measurements and changes in the magnitude of the velocity. If directional measurements are consistent but the velocity decreases with time, then additional measurements are needed to ensure a reliable flow file. It has commonly been observed that consistent flow directions can occur but as the velocity slowly decreases, the flow directions can change and become swirling. This is typical of initial flow measurements in “non-preferential” flow zones. It is important that both direction and velocity stabilize before a measurement can be considered reliable. There are, however, exceptions such as fluctuating pumping rates or boundary conditions. Each situation must be evaluated on a site-specific basis.

Many conditions may be encountered in a monitoring well. It is always important to remember that the instrument is providing a direct measurement of flow conditions in the well at the selected depth interval. Fluctuating boundary conditions such as a river undergoing stage-level changes, cycling pumping wells, or other factors that can induce pressure changes in the aquifer will affect the Colloidal Borescope measurements. These external influences must be considered in order to obtain reliable flow measurements.

The basic principle of AquaLITE

The AquaLITE Software was developed for standard Windows users.

Data from the Colloidal Borescope is transferred to the surface by high strength electrical cable where AquaLITE takes these magnified images and digitizes them at a pre-selected time (frames). The first digitized image is compared to the second image and numerical algorithms determine the best match for all particles. A vector line is then drawn between the matched particles and the distance and direction are added to a file. This data can be graphed and incorporated into various modeling packages, groundwater formulas and general reports. This software has various parameters that can enhance the video signal
and ability to track particles. Like all software, the more you use it, the better and easier it becomes to operate.

**Downloading Latest Software Package**

The AquaLITE software package consists of the main AquaLITE software package, a software driver for the video system, and a USB driver for the magnetometer. All three of these components must be properly installed before using the Colloidal Borescope.

1. To obtain AquaLITE software, visit the following link, navigate to the “Downloads” tab, and select AquaLITE software to download a zip file containing the software and all necessary drivers:


2. If prompted, choose “Save” or “Save As” to download and save the zip file.

3. After downloading, open a Windows Explorer and navigate to the location where you saved the zip file. This is typically in your Downloads folder, or the designated folder your internet browser uses for downloads.

4. To unzip the file and extract the contents, right click on “AquaLITE Software Package.zip” and select “Extract All”. You should see a folder named “AquaLITE Software Package”. Inside that folder, you should see the following contents.

   ![Image of folder contents]

**AquaLITE Software Installation**

1. In the “AquaLITE Software Package” folder downloaded above, run the AquaLITE installer by double clicking on the “AquaLITE Installer.msi” program.
2. The “AquaLITE Setup Wizard” window should open. Click “Next” to start the installation.

3. By default, AquaLITE will be installed into the standard location for Windows (i.e. “C:\Program Files (x86)”). You may select a different install location in the “Select Installation Folder” window. In general, it is recommended to only install for “Just Me” since you may need administrative privileges to install for “Everyone.” Once the installation location is validated, click “Next.”

4. The installation wizard will provide a final confirmation dialogue before the installation process begins. Select “Next” to start the installation.
5. During installation, the setup wizard will display a progress bar.

6. During installation, Window's User Account Control may ask you to validate that you want to install the software. Be sure to select “Yes.”
7. When the installation process is complete, the setup wizard will provide a final “Installation Complete” dialogue window.

Uninstall AquaLITE

To uninstall AquaLITE from your computer, you can either run the AquaLITE Installation.msi program, or you can use the Windows uninstaller through the Windows Control Panel to uninstall the program.

Uninstall Using AquaLITE Installer

1. If you run the AquaLITE Installation.msi program, you will see a dialogue box that asks to “Repair AquaLITE” or “Remove AquaLITE.” By selecting “Remove AquaLITE”, the setup wizard will automatically uninstall the AquaLITE program from your computer. Click “Finish” to start uninstalling the program.
2. During the uninstall, Window’s User Account Control may ask you to validate that you want to remove the. Be sure to select “Yes”

3. You should see a final, “Installation Complete” dialogue box when AquaLITE has been successfully removed from your computer.
Uninstall Using Windows Uninstaller

1. Click on the **Start** button to open your Start Menu.

2. When the Start Menu opens click on the **Control Panel** menu option.

3. When the Control Panel window opens click on the **Uninstall a program** option under the Programs category. This option is shown by the arrow in the image below. If you are using the Classic View of the Control Panel, then you would double-click on the Programs and Features icon instead.

4. You will now be at the Programs and Features, or Uninstall or change a program, screen as shown below.
5. Double click on AquaLITE, or select on AquaLITE and then click Uninstall. You will be presented with a confirmation dialogue. Select “Yes” to remove the program, “No” to cancel the removal process.

6. The program will now begin to uninstall, and when completed you will be back at the list of programs installed on your computer. You will notice that the AquaLITE program is no longer listed.

**USB Driver Installation**

To support the proper operation of the Colloidal Borescope system, Geotech provides custom USB drivers for the magnetometer, which uses a serial-to-usb convertor. Follow the instructions below to install and/or update the serial-to-usb drivers.

1. Detailed instructions for installing the USB drivers are provided in the file titled “Geotech Borescope USB Driver Update.pdf”, inside the “AquaLITE Software Package\USB” folder downloaded above. The instructions below provide only a brief summary of the steps needed to install the driver. Refer to the detailed instructions if needed.

2. Inside the USB folder, there are two different drivers provided based on what version of Windows operating system is being run.
   a. USB_Drivers_PKG_v2.12.26 (for Windows 8/10)
   b. USB_Drivers_PKG_v2.08.28 (for Windows 7 and older)

3. You will need to navigate to a sub-folder to run the dpinst64 program to install the driver on a 64-bit machine (use dpinst32 if using an older 32-bit machine).
   a. In Windows 8/10
      i. Navigate to:
         
         USB_Drivers_PKG_v2-12-26-(Win10)\BBSmartWorx\Windows
ii. Double-click on dpinst64 to start the install process.

b. Window 7 and older
   i. Navigate to:
      USB_Drivers_PKG_v2-08-28\BBelectronics\Windows
   ii. Double-click on dpinst64 to start the install process.

4. Follow the on-screen prompts to install the USB drivers.

**Video Driver Installation**

To support the proper operation of the Colloidal Borescope system, you will need
to install the VCE Express video card manufacturer’s drivers.

1. Detailed instructions for installing the VCE video drivers are provided in
   the file titled “**QUICK START VCE_EXPRESS.pdf**” in the “AquaLITE
   Software Package\VCE” downloaded above. The instructions below
   provide only a brief summary of the steps needed to install the driver.
   Refer to the detailed instructions if needed.

2. Inside the VCE folder, double-click on
   “VCEEx_Software_1_1_0_50.exe” to start installation

3. Follow the on-screen prompts to install the VCE drivers.

**General Layout of Screen**

The general layout of the Geotech AquaLITE Colloidal Borescope Software has a
menu bar (top), two video windows (left), a status screen (center), and a scrolling
chart (right). The menu bar will be discussed in detail below.

The upper video window (Particle Tracking window) displays a graphical
representation of the particles (colloids) being tracked. The lower video window
(Camera Preview window) allows the user to see video image of the particles
moving in the well, as it appears magnified 140 times.

The tracking window displays the particle grabbing and matching process. The
Alpha or first particle is represented by a green cluster (these colors can be
modified in the configuration menu), the Beta or second particle is represented
by a red cluster. A yellow line connecting the alpha and beta clusters represents
the “particle vector”. After all matched particles have been analyzed; the data
will be averaged and added to the file specified in the File-Save section.

The status box in the center details the incoming data. The Tracking and Preview
buttons (toggle red off/green on) allows the user to see if these two parameters
are enabled or disabled. The “Last”, “Avg.”, “Min” and “Max” boxes are capturing
incoming information and displaying for easy reference. Other boxes include the
time (Elapsed time) and data points (number of averaged data points).
The scrolling chart window on the far right displays information on the measured particles over time. In general, the scrolling chart displays the direction and speed (velocity) of the particles as measured by the Colloidal Borescope. Additionally, the number of particle counts can be charted as well if desired. To maintain performance, the chart only contains and displays the last 4096 data points that were recorded. If the number of data points collected is less than 4096, the chart will keep adding data. Once the limit of 4096 is reached, the chart will begin to scroll the data. Because each well is different, the number of colloids that are tracked will vary with time. Thus, the window of time displayed in the scrolling chart will vary from well to well, and even across different runs.

**Compass Configuration:**

Before creating a new file:

*File – Compass – View/Configure Compass*

OR

Once a new file has been created:

*Configuration – Compass (F7)*

Compass configuration is necessary before opening a new file or beginning to track data. Navigate to the compass configuration screen, connect the probe and the CCU, and turn the CCU ‘ON.’ Ensure you are receiving a reading by seeing “Success” and a red needle that changes as the Borescope is rotated around its vertical axis.
If there is no immediate reading, check the RS-232 COM port # in Windows > Device Manager, adjust as necessary, and power cycle the CCU. Sometimes a baud rate adjustment is necessary; activate this feature with the “Diagnose” button on the configuration screen. See Section 5: Troubleshooting & FAQs for further information.

**General Overview of Menu Bars and Sub-Menus**

**File – New (Ctrl+N)**

The user will be prompted to input the following:

**Well Name:**
Alphanumeric field, specific identifier for the well of interest.

**Depth:**
Alphanumeric field, depth that the Colloidal Borescope instrument is viewing and tracking. Enter in “feet” or “meters”.

**Date:**
Automatic Field Date. Can be modified.

**Magnetic Declination:**
Magnetic Declination can be found in Section 3: System Check, Installation & Deployment (for the United States only).

**File – Open (Ctrl+O)**
Open a previous file.

**File – Close**
Close current file. Does not exit the program.

---

**Viewing/Printing Well Analysis Summary**

After a logging event, AquaLITE will analyze the data and create an in-depth, cohesive Well Analysis Summary. There are a few options to view this report, they are outlined below.

**File – Print (Ctrl+P)**
With this option, AquaLITE will offer a few options. “Print Summary” will print only the Well Analysis Summary, only the graph, or both. These files can be printed to PDF, depending on the device setup on the configured laptop.
**Explanation of the Well Analysis Summary Sheet:**

The AquaLITE software offers a report for the user. The report gives the well, date and data information (top), general statistical analysis (middle), and a vector-based analysis (bottom).

The general information (top) gives the well name; the statistical analysis (middle) offers the basic statistics that can be used for direction and speed determination. These values are taken from the data file and are simply run for average, median, minimum, maximum direction, and the standard deviation. These values must be scrutinized for accuracy of depth of observation, angle or azimuth reading entered while collecting the data, date, time, and total number of data points collected during the observation. In addition, average direction values should be compared with Flow Direction, as there can be differences. The report also gives the same statistics for the speed data. This data must also be scrutinized, as an elevated average will occur if the file was initially started before flow stabilized from insertion of the Borescope into the well.

The Vector-based Analysis (bottom) was created to help with determining the true direction and velocity when there are large variations in the data. One must be careful in comparing the vector values with the average flow rate or directional
measurements because the mathematical statistics are different when considering an average of all the measured quantities (for example, speed alone) as compared to taking the average of a vector that describes the direction and speed.

As an example, if a particle is moving due north at 200 um/s and a second particle is moving due south at 100 um/s, then the average of the speeds and directions would show a flow rate of 150 um/s in a due east direction, respectively. However, in a vector-valued average the result will show a flow rate of 100 um/s in a due north direction. It is clear that the net flow is more properly represented by a flow of 100 um/s in the north direction, and not the value obtained with direct averaging that results in an estimate of flow to the east.

There can be cases where if two nonadjacent quadrants contain the highest number of data points, then an erroneous reading can results. This case, however, is rare and based on experience only occurs during swirling flow--which is unreliable to begin with. The software will note that these files are "unreliable for direction determination" for the Flow Direction reading. The Well Analysis Summary Sheet has been offered to the user only as an added benefit for determining the "True" direction and velocity. Only a certified Colloidal Borescope Operator should make the appropriate determination of direction and velocity.

Configuration Field: Well, Tracking, Video, and Graph.

**Configuration – Well (F3):** allows modification of well parameters entered when creating a new file, i.e., name, depth, azimuth and date.

**Azimuth:**

The Borescope probe’s magnetic heading in well. The software will use this information to provide velocity and trajectory data relative to true North, regardless of probe orientation.

Automatic azimuth detection via AquaLITE is recommended, as manual azimuth entry should only be used if down well probe orientation is known.

**Configuration – Tracking (F4):**

It is recommended to change only one or two tracking configuration fields at a time. Allow the unit to stabilize after making edits to ensure controlled, sensible tracking configuration edits.

**Capture Delay (milliseconds):** Sends a signal to the frame grabber to snap the second comparative image every 1 to 99999 milliseconds. Setting the window to 1 allows the software to grab as fast as possible.

**Particle Sensitivity:** This parameter acts like a filter. Increase this value if large amounts of colloids exist or electrical interference is present. Lower the value if only a few colloids exist and the electrical source is
clean. This parameter will need to be changed throughout a session as colloids decrease (Normal Range is between 1000-5000). This is ONLY the Normal Range can be smaller or larger depending on the conditions of the aquifer.

**Minimum Particle Size (um):** This is another way of filtering out small electronic interference or slimes. Set the number higher to remove small particles.

**Maximum Velocity:** Filters out matches higher than this number (good for filtering out bad matches or electrical interference). Set this value 100-200 higher um/sec than observed particle velocity. Be Observant! Velocity can and will change during observations.

**Minimum Matches:** The number (1 to 999999) tells the software to only enter the value in the data if the conditions exist that number of matched exists. 1 to 2 is the normal operating value.

**Borescope Image Size (microns):** DO NOT CHANGE. These numbers will be calculated before purchase. These numbers are the actual size (in microns) of the fixed focal point. If accidentally removed or edited, use 2500 x 2000 (width x height) as default.

**Alpha and Beta Particle color** allows the user to specify the color of the first and second grabs for easy display. Default is Alpha = green, Beta = red.

**Configuration – Video (F5):**

Allows changes in the video driver and configuration. IMPERX VCE cards will show a hardware screen; refer to VCE card instructions booklet for more information.

**Video Configuration** Allows the user to specify the specific video parameters i.e., RGB and color settings.

**X-offset and Y-offset** crops the capture image and removes interference on side of image.
**B (Brightness)** sets the image brightness. This will need to be adjusted after Borescope is inserted into well.

**C (contrast)** sets the image contrast. This will need to be adjusted after Borescope is inserted into well.

**S (Saturation)** sets the saturation (leave at 0).

**H (hue)** sets the Hue (leave at 0).

All Other fields will be set back to original if modified!

**Video Driver** sets the MRT Video Port video capture device driver (If error code states video card no longer exists, then reboot computer).

**Configuration – Graph:**

Allows changes in the graph appearance.

This option allows multiple changes to all aspects of the graphing software. There are too many options to describe in this manual. The main options that the user will find beneficial are the Data Tab and the Colors and Styles Tab.

---

**Preview Menu- (F2)** or clicking on the red preview button (located in the upper right hand corner of the data information window) previews the image in the lower image box. Preview allows the user to see the video image in the well. Change the brightness and contract parameters detailed in the Video Format Menu, if the picture is too light or dark or out of focus.

---

**Tracking Menu- (F1)** or clicking on the red tracking button (located in the upper left-hand corner of the data information window) starts the tracking program in the upper image box. The preview button (F2) must be activated before the tracking operation will work! Once the tracking button is on, the upper video window will display the alpha and beta particles with the yellow matching line in between. Change the tracking configuration as outlined earlier for the most grabs. Turn tracking off before changing any configuration parameters.

---

**View Menu:**

**Normal View** displays both the preview screen and the tracking screen with status area (normally highlighted).

**Graph View** displays the graph only "below" (while in tracking mode, the graph will automatically update as the data is captured). This utility allows the user to track the data (i.e., a preferential flow zone or a swirling flow zone). Having the graph view on however, will slow the
program as this takes up the available computer memory. Hence, it is a good idea to check the graph regularly then return to the normal view.

**Window Menu:**

- **New** option allows for a new tracking window. Primarily used if an existing file has been used.
- **Cascade** Aligns the windows from upper right to lower left. Used if multiple files are open.
- **Tile** Aligns the windows from upper center to lower center. Used if multiple files are open.
- **Align Icons** Typical Windows aligning protocol.
- **Split View** displays the graph and the Tracking screen. Not recommended while tracking is on, as the computer’s resources are limited. To return to normal view, simply click “View-Normal.” If tracking has stopped then double click on the tracking button to start the tracking.

**Other Commands:**

- **Save the File**
  Save the file in the directory of choice

- **Open a File**
  Opens a previously created file

- **Print the File**
  Option allows user to print report, graph or both (see Print and Preview commands below)

- **Preview the File**
  Allows user to see report, graph or both prior to printing

- **Print Setup**
  Allows user to select printer and printer options

- **Report Font**
  Allows user to select from many font types for report output

- **Export Log Data**
  Allows user to export data (.log) for use in other spreadsheets

- **Import Log Data**
  Allows user to import data from previous versions of AquaVIEW/LITE
Section 3: System Check, Installation & Deployment

It is recommended that the operator read the journal article by Kearl (1997, Journal of Hydrology, 200, 323-344) for an understanding of the theory of groundwater flow in a borehole, observed flow conditions, and laboratory testing of the instrument.

System Hook-Up, Operational Check, & Data Collection Tests

After unpacking the Colloidal Borescope system and installing the AquaLITE software, an operational check should be conducted prior to field deployment. The following procedure is recommended:

1. Connect the CCU’s power adapter to a 90-240 VAC supply. Ensure that the CCU ON/OFF switch is turned OFF.

2. Connect the cable between the Borescope Probe and the CCU.
   - Before plugging the connector into the probe, make sure the sealing surfaces are clean and lightly lubricated with silicon grease or other seal lubricant.
   - Align the large pin hole on the probe with the large pin hole on the connector.

   Figure 3-1: Aligning the pin

   - Do not overtighten cable. Tighten only until the cable connector stops turning.
   - The cable connector will spin when the connector is loose.

3. Locate the USB-to-USB cable provided with the system; connect the “USB Port” from the CCU into a USB port on the laptop.

4. Locate the VCE Express video card (54mm) provided with the system; connect the “Video Out” from the CCU to the Express Card Slot on the laptop.
5. Install and open AquaLITE and navigate to **File – Compass – View/Configure Compass**.

6. Turn the CCU ON/OFF switch to **ON**. In a few seconds, the green compass circle should show a red needle indicating the probe heading (internal compass). Rotate the probe around the vertical axis and verify that the red needle moves in a relative fashion. See *Section 5: System Troubleshooting & FAQS* if unable to read-in compass heading.

7. Set up a new project in AquaLITE, File > New. Enter a test well configuration, as well as magnetic declination. For the United States, use the graph in this section.

8. The AquaLITE video screen should be white, and the colloidal back light should be on. Enable “Preview” status and observe the video screen shift color. Place a small object (pencil tip, piece of paper, finger, etc.) approximately midway between the backlight head and the camera. A magnified, silhouetted image should be observed on the monitor. Move the object up and down within the field of view to characterize the focal point.

9. Hold the Borescope with the backlight head down and rotate the unit around its vertical axis. Observe the compass display on the monitor to make sure it changes smoothly and corresponds to the angular position of the Borescope. Confirm cardinal orientation, North = 0°.
Figure 3-2: Magnetic Declination: USA
Now that the Borescope is set up and delivering live video, we recommend conducting a quick in-office test to gain experience with viewing, collecting, and analyzing data. The test uses a water bucket and municipally plumbed water source (tap or faucet) to observe predictable velocities and directions. Follow the instructions below:

1. Recommended Settings for in-office bucket test:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Capture Delay (milliseconds)</td>
<td>100</td>
</tr>
<tr>
<td>Particle Sensitivity</td>
<td>2800</td>
</tr>
<tr>
<td>Minimum Particle Size</td>
<td>3</td>
</tr>
<tr>
<td>Maximum Velocity</td>
<td>5000</td>
</tr>
<tr>
<td>Minimum Matches</td>
<td>2</td>
</tr>
<tr>
<td>Data Point Frequency (seconds)</td>
<td>0</td>
</tr>
<tr>
<td>Borescope Image Size (microns)</td>
<td>2500 x 2000</td>
</tr>
</tbody>
</table>

2. Fill a bucket with at least 8” (20.3 cm) of water so that the bottom portion of the Borescope can be submerged.

3. Ensure that “Preview” is enabled (green), and toggle the “Tracking” button on AquaLITE. If a hazy “Preview” screen is evident, toggle the “Preview” button a couple of times.

4. Swirl the water in the bucket clockwise, and place the Borescope in the water against the north side of the bucket for at least 20 minutes. Using the Graph View, observe the colloidal particles moving towards the east (90°), and observe the velocity decreasing as the water slows down and the particles begin to swirl in multiple directions. When viewing the graph, you should see a decrease in velocity as the water slows down, and the direction lines should start to represent swirling flow (Figure 3-3).

5. Repeat above, but place the Borescope against the south side of the bucket; the particles should now be moving west (270°). When placed on the west side of the bucket, the particle movement is north, and when placed on the east side of the bucket, the particle movement is south.

6. Conduct the experiment again; pay note to the orientation of the compass versus output data. Try different orientations to gain a thorough understanding. No manual adjustments/calculations are required when interpreting data.

7. View the live test graph to help understand how the instrument will be reading and transmitting data; this in-office test should provide practice and precedent for field measurements.

Disconnect, dry, and store all system components in preparation for field installation.
Figure 3-3: Bucket Test Data Report
Installing & Preparation for Field Measurements

When deploying equipment in the field with portable power, be sure to read and understand your portable generator’s User Manual for proper installation, operating, and earth ground instructions. Failure to do so may result in unaccounted static disturbance during data collection.

For the Colloidal Borescope to provide reliable measurements of groundwater flow rates and directions, it is important that the instrument be placed in a developed, high quality well. The well screen should consist of mechanically slotted screen with a minimum of three columns of slots or wire-wound screen. Prior to measurements, the well should be adequately developed using a jetting tool or mechanical surging. A low permeable skin surrounding the well screen will result in groundwater flowing around the well and swirling flow within the well. Finally, any devices in the well such as dedicated pumps should be removed from the well at least 24-hrs prior to testing. This will allow the ambient hydraulic conditions in the well and the surrounding porous media to re-establish and any turbidity effects from removing the pump to subside.

Prior to placing the Colloidal Borescope in a test well, the video image should be checked by placing an object such as a pen between the lens and the backlight. The Borescope should be slowly lowered into the well to minimize disturbing the formation, which may result in excessive turbidity in the well. If this occurs, there will not be a clear picture on the video screen and several hours or perhaps a full day may be required for the well water clarity to return.

The Colloidal Borescope provides depth specific measurements of groundwater flow direction and velocity. Several important factors must be considered in order to obtain a reliable measurement. It is widely accepted that flow occurs in preferential flow zones within subsurface aquifers. These preferential flow zones dominate groundwater flow even in "homogeneous" aquifer. For a reliable measurement, the Colloidal Borescope must be placed in these preferential flow zones.

A combination of relevant geologic information and the proper utilization of the Colloidal Borescope system are necessary to locate and measure these preferential flow zones. Prior to flow measurements, the geologic log for a particular well should be consulted and possible high permeable zones selected. Based on this information, the Borescope should be placed in the center of these zones. Subsequent measurements should offset by selected intervals from the initial zone until a preferential zone is located.
System Deployment & Data Interpretation

Always use a grounding wire attached to the power supply if inserted into a stainless steel or metal cased well.

With the CCU’s power switch turned off, connect all CCU cables to the laptop and to the probe. Initialize the AquaLITE software, turn on the CCU, check the compass configuration, and then begin probe deployment.

When the Borescope is lowered in position and the well has settled, use the knob on the camera control unit to adjust the backlight (low, medium, high intensity) for optimum contrast and observation of the maximum number of colloidal particles. In relatively clear water, the best results are obtained with the backlight at a low setting.

Use the AquaLITE software to gather data, as outlined in the *Section 2: System Software, AquaLITE.*
Section 4: System Maintenance & Calibration

Regular Maintenance

Maintenance for the camera and light head is limited to cleaning and maintenance of the O-ring seals, and cleaning the housing and window.

Lens

To avoid scratching the windows, they should only be cleaned with mild soap and water. During cleaning, flush the windows with clean water then use a small amount of mild soap on your finger to gently clean the windows. Allow to air-dry or gently dry with a soft cloth or lens tissue.

O-Rings

The O-rings in the housing and light head should be inspected on a yearly basis, and should be replaced if any damage is noted, or if they appear to be flattened or deformed in any way. During replacement, the O-rings, O-ring grooves, and mating surfaces should always be clean, and should be lubricated with silicon grease or other O-ring lubricant before assembly.

Backlight LED

The light head uses a long life LED that should not require regular maintenance. If replacement is necessary, the lamp assembly should be replaced as a complete unit. This is accomplished by first removing the retaining ring on the light housing, and withdrawing the end closure by inserting a 1/4-20 bolt for use as a puller. The lamp assembly can then be taken out by removing an internal retaining ring and unsoldering the leads to the lamp.

After replacing of the lamp circuit, check the O-ring seal and mating surfaces for cleanliness, and for any nicks or scratches. Replace the O-ring if damaged. Lubricate the O-ring and mating surfaces with a light coating of O-ring lubricant, install the O-ring, and replace the end closure and retaining ring. If repair or replacement of other components is necessary, please contact Geotech Environmental Equipment, Inc.

Laboratory Calibration

An extensive laboratory-testing program was undertaken to determine the accuracy of the Colloidal Borescope for determining groundwater flow direction and rate. Details of these laboratory tests are presented in Kearl (Observations of particle movement in a monitoring well using the Colloidal Borescope. 1997 Journal of Hydrology, 200, 323-344).

Factory calibration

The Borescope is calibrated and verified before leaving the factory, making the instrument ready for deployment.
The magnification factor for the software is checked by measuring the width and length of a micrometer placed in the field of view.

The final pre-shipping test involves the placement of the instrument in water and observing the particles passing through the field of view, as well as testing the tracking software via AquaLITE. For example, if the particle is observed at the top of the field of view and moves toward the bottom of the field of view, then the resulting direction tracked calculated by the imaging software should be approximately 180 degrees.

Field Tests

To ensure the Borescope is in operating condition, conduct this simple test to ensure the Borescope is aligned with Earth’s magnetic North.

1.) First, determine magnetic north with an external Compass.
2.) Open AquaLITE > File > Compass > View/Configure Compass, and align the internal Borescope compass with North, or 0 degrees on the configuration screen.
3.) Keeping the compass stable, open a new well tracking file, and initiate “Preview” mode.
4.) The bottom screen should now track any objects moving in and out of the field of view.
5.) Place a small object (ex: pen tip) at the North side of the field of view, and move it towards the South; observe that the “Preview” screen shows the object moving from top to bottom. Moving the object West to East should correlate with the Previews screen left to right.

If the Borescope follows the conditions laid out above, it is in pristine working condition. Should any other behavior be observed, please contact Geotech Environmental Equipment, Inc. for further assistance.
Section 5: System Troubleshooting & FAQs

If you are experiencing other problems than mentioned in this section, please contact Geotech at sales@geotechenv.com so that others may benefit from your experience!

Problem: No picture with the instrument in the well
Solution:
There are several possible causes of no picture from the instrument while in the well.

- Make sure all connections are complete as shown in Figure 1-1 and Figure 1-2. Check contrast and brightness levels in the Video Source Menu (increase or decrease brightness depending on preview color, if preview screen is blue then check to see if the BNC cable from the camera control unit to the computer Express slot is plugged in). There is a light adjustment switch on the Camera Control Unit; however, this is only for small light increases.
- Is system powered up? Check to see if the Colloidal Borescope red backlight is ON. Camera control unit and laptop must be ON!
- Is Borescope sending the compass readout to the Compass Configuration screen in AquaLITE? If the compass is providing a reading, then the turbidity of the well may be too high. Remove Borescope from well and look at lenses. Place object under lens to see if image comes back. If not, check to see that the seals have not been breached and water has entered the camera compartment. If image looks fine on surface then well is most likely too turbid to characterize. Another well should be selected until the water clarity returns.
- If there is no compass reading, recheck all power supplies and cables. Make sure to use grounding wire if a Power Inverter is being used to supply power to equipment in the field. If the grounding wire is not used, damage can occur to the camera.

Problem: Abrupt change in groundwater flow direction
Solution:

- If consistent directional flow is interrupted by an abrupt change in flow direction, the first item to check is the velocity graph. If there has been a steady decline in the magnitude of the velocity when the directional change occurred, then chances are the measurement zone is a non-preferential flow zone and the Borescope should be moved to a different test interval.
- If velocity is consistent, check for outside interference such as pumping wells, tidal influences, or fluctuating river stages. Even in steady preferential flow zones, short-term directional changes can occur. Continue to observe for 10 -15 minutes. If direction changes to a third direction, then the Borescope is in a non-preferential flow zone.
Problem: Numerous particles are being grabbed but no data is being recorded
Solution:
- If this condition occurs, then the maximum velocity setting in the Tracking Configuration is lower than the velocity of the particles. Reset the maximum velocity to a value approximately twice the measured velocity.

Problem: Numerous particles are being grabbed but computer is slow writing to file
Solution:
- First option is to increase the particle sensitivity until only a few particles are being grabbed.
- The second option is to click on the tracking window and manually drag (decrease) the size of the window so that the grabbing area is smaller. This tells the software to grab only that portion of screen. This works well if there is something obstructing a portion of the video image i.e., large debris, mud, or synthetic material on the lens or backlighting source (drag the preview box away from that portion of the frame grabber).

Problem: Loss of particles in the viewing area
Solution:
- For aquifers that contain few colloidal particles such as coarse grain sands, particle density may decrease to one or two particles every minute. Be sure to set the delay between frames to the minimum values possible. The particles between the two frames, however, should not overlap to ensure an accurate measurement. Several hours may be required at a test interval in order to obtain enough particle matches to ensure a reliable flow zone.
- Another potential problem is if the particles become blurry and then disappear altogether. This effect could result from a dirty well. Numerous particles can settle on the backlight source and decrease the amount of light available for viewing. Gently shaking the Borescope can remove these particles and allow a good image without disturbing the fines in the surrounding formation. Be sure to carefully lower the Borescope into these types of wells.

Problem: No flow zones detected in a well
Solution:
- First, keep trying different zones within the well screen. Remember, preferential flow zones can be in small laminar zones (a matter of inches), so keep on looking!
- If 5 to 10 measurements were taken in a 5’ (1.5 m) well screen and no steady consistent flow zones where found, then the instrument should be moved to a new well. It is possible that the well is located in a stagnant flow zone within the aquifer; however, it is more likely that the well was poorly developed and there is a low permeable skin surrounding the well thus deflecting groundwater around the well. Another possibility is that the well was screened is a low permeable...
zone of the aquifer with surrounding preferential flow zones that do not intersect the well screen.

- It may seem obvious, but recheck the well log to ensure that the Borescope is located in the well screen and not the well casing.

**Problem: Poor flow zones with particles that appear on the screen then rapidly disappear.**

**Solution:**

- If this problem occurs then there are large vertical gradients in the well. Particles that stay in focus only briefly are moving across the focal plane of the lens. Well screens that intersect two or more permeable flow zones with different potentials can result in vertical flow in the well. Attaching packers to the instrument may reduce this vertical flow component.

**Problem: Poor flow zones in large diameter wells**

**Solution:**

- If this condition occurs, then it is recommended that the packers be attached to the instrument. The packers centralize the Borescope, keeping it off the sides of the well screen and minimize vertical flow that may be affecting the measurements.

**Problem: Software Crashes**

**Solution:**

- Restart by double clicking on AquaLITE icon. If problem still exists then reboot computer.

**Problem: Software will not track particles**

**Solution:**

- Check the delay setting in the *Tracking configuration menu*. The faster the particles are moving the smaller the "Capture Delay Frame" value should be and vice versa.
- Check the *Particle Sensitivity* in the same menu screen. If numerous particles exist on the preview screen then the sensitivity should be increased to approx. 2500-4500). If only a few particles are visible then the sensitivity should lowered to be between 500-2000.
- If the visible amount of particles is overwhelming, click on the tracking preview window (upper) and drag the box corners in so that the image window is smaller. This tells the software to grab only that portion of the image. This works well is there is something obstruction a portion of the preview screen then the sensitivity should be increased. This tells the software to grab only that portion of the frame grabber. Turn particle tracking off and on again.
- Turn tracking off while viewing graph and/or modifying parameters. Turn back on after changes are made.

**Problem: Backlight source does not work**

**Solution:**

- Check all cables to ensure connections are right. Check 1 amp fuse within Camera Control Unit (above plug outlet). If camera is sending image (use auxiliary light and look at monitor) and if no light is present,
it is possible that the internal camera unit has been jarred and is not contacting the two light source connections.

- THE FOLLOWING SHOULD BE PERFORMED BY AN AUTHORIZED/TRAINED COLLOIDAL BORESCOPE OPERATOR.

Remove three screws from lower light unit on Borescope (note position of light unit compared to Borescope, mark with pen if needed). Pull the light unit apart. Check with a multi-meter for power from Borescope, voltage should read approximately 12 millivolts. Tap instrument so that camera unit slides towards the open end. Replace light unit (matching pen lines). Light should come on at this point. Remove light unit, replace rubber seals and add silicon (vacuum grease). Replace light unit (matching pen lines).

- If light does not work at this point, check depth of contact with ruler and check depth of light source to ensure contact is being made. Make sure that the spring contact is not stuck. If camera unit will not move or there is no power to light source, equipment must be sent back to Geotech for repair.

**Problem: Compass software cannot find port.**

**Solution:**

- From the Windows start menu click *Settings – Control Panel – System – Hardware – Device Manager – Ports* and simply see which port is being used by AquaLITE. Then go back into AquaLITE and in the *compass calibration – automatic – port* – scroll down to highlight the appropriate port and retry. Power cycle the CCU to reset the connection.

**Problem: Unable to test unit.**

**Solution:** Use the following steps to set up the Borescope for testing:

1. Power on computer.
2. When AquaLITE starts, close AquaLITE and let computer finish start-up.
3. While waiting for the computer to complete start-up, obtain USB, VCA, Power, and Borescope.
4. Make all connections to the Camera Control Unit. (See Figure 1-4)
5. Connect Borescope to the down hole reel.
6. Open the Device Manager on the computer
   - System Properties>Device Manager
7. When computer has completed start-up, install Video Card and USB.
   - Do not power on Camera Control Unit.
   - Ensure all components are recognized by checking “Ports (COM & LPT)” and “Sound, video and game controllers”.
   - Will read as “VCE express capture card”.
8. Locate “Mice and other pointing devices”.
9. Disable Microsoft BallPoint Pointer by right-clicking and selecting “Disable” (if applicable).
   - Microsoft BallPoint Pointer may attempt to occupy the same communication port as the compass. If Microsoft BallPoint Pointer is not disabled, it can cause glitches, disable the mouse cursor, and disrupt the compass.
10. Open AquaLITE.
11. Power on Camera Control Unit.

Testing Unit Functionality:

1. Press F7 or to the Configure tab and select “Compass configuration”.
   - Azimuth is represented by a red line.
   - Bearing is represented in degrees.
   - If there is no red line or displays, “No Data” or “Time out on rec’d data” toggle between “Manual” and “Automatic” in the “Compass Configuration” window to jump start the unit and allow for compass readings.
   - You may need to cycle power on the Camera Control Unit.
2. Place an object in front of the viewing window of the Borescope.
3. Press F2 or click on the red box next to preview in the middle of the screen.
   - Toggle window ON and OFF to verify picture.
4. Press F1, with preview on, to test tracking capabilities
   - Should show green, red, and yellow lines or dots. (Unit is tracking object).
   - If no object is shown in the window but is constantly tracking, parameters will need to be adjusted.
5. Press F4 to bring up the parameters.
   - Adjust one parameter at a time. This will take some time to be properly adjusted. See Section 2: System Software, AquaLITE for default settings.

If the unit still does not work:

- Ensure all cords and cables are properly attached. Refer to Section 3: System Check, Installation & Deployment.
- Ensure the computer recognizes all devices by going to System Properties>Device Manager and checking “Ports (COM & LPT)” and “Sound, video and game controllers”.
- Flex test the cable, specifically where it connects to the Borescope, to check if the compass drops when the cable is flexed. If the compass drops when the cable is flexed, the unit may need to be sent back to Geotech for repairs.
- Check if light on the Borescope turns on and confirm the light can be adjusted. Refer to Section 3: System Check, Installation & Deployment.
- Ensure there is no moisture inside the body of the Borescope by looking into the camera window. If there is moisture inside the Borescope, the system may need to be sent back to Geotech for repairs.

Frequently Asked Questions

What is the minimum particle size and ratio needed for the Colloidal Borescope to function properly?
• The limit is somewhere between 200 and 500 NTU. Naturally, occurring particles are between 5um and 20um. Particle sensitivity is just less than 1um.

What is the minimum velocity that can be detected?
• As many days, weeks, months as user is willing to spend taking measurements determines the minimum velocity. Minimum velocity is essentially zero. If a particle sits in the field of view, it will not be tracked until it moves. For example, if it takes a year to move 1um then the flow speed would be 1um per year.

Is additional data manipulation required to account for the azimuth?
• No. After entering in magnetic declination, the AquaLITE software will always orient to true North, regardless of the azimuth. The azimuth reading is present to help the user orient their view when watching the live video feed and tracking.
Section 6: System Specifications

Borescope Specifications

Applications: 2” (5.8 cm) or larger well Diameter

Maximum Operating Depth and Submergence: 1000’ (305 m)

AC Power Requirements*: 90-240V AC, 47 to 63 Hz. 7 Watts. Service requirement < 1 amp

DC Power Requirements*: 10 to 16 VDC @ < 1 amp

Probe Size: 21.25” L x 1.75” OD (54 cm L x 4.5 cm OD)

Probe Weight: 5 lbs. (2.5 kg)

Probe Housing Material: 300 series stainless steel

Window Material: Sapphire

Camera Control Unit size: 3.98” W x 7.89” L x 3.16” H (10 cm W x 20 cm L x 8 cm H)

Camera Control Unit Weight: 2lbs (.9 kg)

Cable Size: .375” OD (.95 cm) Customer specified length from 100’ to 1000’ (30.5 m to 305 m)

Cable Jacket Material: Urethane (composite cable material ROHS compliant)

Electrical Component Material: Non ROHS compliant, dispose of properly

Operating Temperature Range: 14° F -113° F (-10°C to 45°C)

Camera Field of View: 2.5 mm to 2 mm

Depth of Focus: .2 mm

Minimum Ground Water Velocity: 0 mm/s

Maximum Ground Water Velocity: 30 mm/s

Minimum Particle Size: 10 µm

Maximum Particle Size: Within camera field of view

Heading Accuracy: 1.0°RMS typical

Heading Resolution Output Data: 0.1°

Heading Hysteresis Output Data (1s): +/-0.3°

Cable Lift Capacity: 426 pounds (193 kg)

Compass Resolution: 1°

Compass Accuracy: +/- 1°

*Not including laptop or PC
Borescope Specification Notes

- Interpretation of local magnetic declination maps may vary by user.
- The speed is calculated using the frame rate of the camera and the field of view.
- The clock that determines the frame rate of the camera is accurate to 0.1 microseconds. This error is negligible when propagated through the total error sum.
- The field of view is measured using a micrometer glass slide with 50μm interval divisions.
- Spread over the nominal field of view area this gives approximately .5% uncertainty of measurement.
- The resolution of the measurement is 10μm. This is based on the diagonal dimension of the rectangular pixel size of the camera sensor. 9.75μm
- The speed of a colloid in the groundwater is a function of the field of view and the frame rate of the camera. Given these known values, a calibrated flow rate test is unnecessary, if not inappropriate. However, it has been extensively tested and documented. Details of these laboratory tests are presented in Kearl (Observations of particle movement in a monitoring well using the Colloidal Borescope. 1997 Journal of Hydrology, 200, 323-344).

AquaLITE Software Requirements

Pentium based laptop computer with an available Express Card slot (54mm).

Windows 7 or newer, Windows Server 2008 R2 SP1 or newer.

At least 8 MB of free hard disk space in the Windows Drive.

At least 13 MB of free hard disk space.

At least 12 MB of RAM, 32 MB is recommended.
## Section 7: Parts and Accessories

### Complete Borescope Options

<table>
<thead>
<tr>
<th>Parts Description</th>
<th>Part #</th>
</tr>
</thead>
<tbody>
<tr>
<td>BORESCOPE, 100' CABLE COMPLETE UNIT, ON HAND REEL</td>
<td>92070001</td>
</tr>
<tr>
<td>BORESCOPE, 200' CABLE COMPLETE UNIT, ON HAND REEL</td>
<td>92070002</td>
</tr>
<tr>
<td>BORESCOPE, 300' CABLE COMPLETE UNIT, ON SMALL REEL</td>
<td>92070003</td>
</tr>
<tr>
<td>BORESCOPE, 400' CABLE COMPLETE UNIT, ON SMALL REEL</td>
<td>92070004</td>
</tr>
<tr>
<td>BORESCOPE, 500', CABLE COMPLETE UNIT, ON SMALL REEL</td>
<td>92070005</td>
</tr>
<tr>
<td>BORESCOPE, 600' CABLE COMPLETE UNIT, ON SMALL REEL</td>
<td>92070006</td>
</tr>
<tr>
<td>BORESCOPE, 700' CABLE COMPLETE UNIT, ON LARGE REEL</td>
<td>92070007</td>
</tr>
<tr>
<td>BORESCOPE, 800' CABLE COMPLETE UNIT, ON LARGE REEL</td>
<td>92070008</td>
</tr>
<tr>
<td>BORESCOPE, 900' CABLE COMPLETE UNIT, ON LARGE REEL</td>
<td>92070009</td>
</tr>
<tr>
<td>BORESCOPE, 1000' CABLE COMPLETE UNIT, ON LARGE REEL</td>
<td>92070010</td>
</tr>
</tbody>
</table>

### Accessories

<table>
<thead>
<tr>
<th>Parts Description</th>
<th>Part #</th>
</tr>
</thead>
<tbody>
<tr>
<td>LAPTOP, DELL E6530, REFURBISHED</td>
<td>77500028</td>
</tr>
<tr>
<td>LAPTOP, DELL, RUGGED LAT5424, NEW</td>
<td>77500029</td>
</tr>
<tr>
<td>BATTERY, EXTENDED LIFE, DELL</td>
<td>17500678</td>
</tr>
<tr>
<td>ASSY, CENTERING DEVICE</td>
<td>52070018</td>
</tr>
<tr>
<td>CAP, DEL, PROTECTIVE, CAMERA, BORESCOPE</td>
<td>22070035</td>
</tr>
</tbody>
</table>

### Repair Parts

<table>
<thead>
<tr>
<th>QTY</th>
<th>Parts Description</th>
<th>Part #</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>CONTROL BOX, BORESCOPE</td>
<td>52070002</td>
</tr>
<tr>
<td>1</td>
<td>ASSY, 7' POWER CORD, AC, W/AMP</td>
<td>57500007</td>
</tr>
<tr>
<td></td>
<td>ASSY, 15' POWER CORD, DC W/ AMP, W/ ALLIGATOR CLIP</td>
<td>57500008</td>
</tr>
<tr>
<td>1</td>
<td>VIDEO CARD, BORESCOPE, W/ CABLE</td>
<td>22070030</td>
</tr>
<tr>
<td>1</td>
<td>CABLE, 8 PIN MOBO TO S-VIDEO VCE CARD/B SCOPE</td>
<td>12070069</td>
</tr>
<tr>
<td>1</td>
<td>CABLE, S-VIDEO TO MALE RCA VCE CARD/B SCOPE</td>
<td>12070071</td>
</tr>
<tr>
<td>1</td>
<td>MANUAL, BORESCOPE</td>
<td>22070014</td>
</tr>
<tr>
<td>1</td>
<td>CASE, PELICAN, 1600, BLACK, W/ FOAM</td>
<td>17500020</td>
</tr>
<tr>
<td>1</td>
<td>ASSY, CABLE, BORESCOPE, CCV/REEL</td>
<td>52070004</td>
</tr>
<tr>
<td>1</td>
<td>REEL, HAND, BLACK, &quot;B&quot;</td>
<td>72050629</td>
</tr>
</tbody>
</table>
1  REEL, PORTABLE, SMALL  11400010
1  REEL, PORTABLE, LARGE  11400011

1  FLYING CABLE, INLINE, 100' BORESCO STD CONN, NO REEL CONNECTION  52070006
1  FLYING CABLE, INLINE, 200' BORESCO STD CONN, NO REEL CONNECTION  52070005
1  BULKHEAD CABLE, 300', BORESCOPE BULKHEAD CONN FOR SMALL REEL  52070007
1  BULKHEAD CABLE, 400', BORESCOPE BULKHEAD CONN FOR SMALL REEL  52070008
1  BULKHEAD CABLE, 500', BORESCOPE BULKHEAD CONN FOR SMALL REEL  52070009
1  BULKHEAD CABLE, 600', BORESCOPE BULKHEAD CONN FOR SMALL REEL  52070010
1  BULKHEAD CABLE, 700', BORESCOPE BULKHEAD CONN FOR LARGE REEL  52070011
1  BULKHEAD CABLE, 800', BORESCOPE BULKHEAD CONN FOR LARGE REEL  52070012
1  BULKHEAD CABLE, 900', BORESCOPE BULKHEAD CONN FOR LARGE REEL  52070013
1  BULKHEAD CABLE, 1000', BORESCOPE BULKHEAD CONN FOR LARGE REEL  52070014

1  ASSY, PROBE, DOWNWELL, BORESCOPE  52070003
2  O-RING, NTL, 38MM X 2MM  12070037
1  O-RING, NTL, 22MM X 2.5MM  12070038

1  ASSY, CENTERING DEVICE  52070018
1  CLAMP, FLOW RESTRICTOR  22070018
1  RING, CENTER, RUB, 3.75 OD X 1.75" ID  12070053
1  SCREW, SET, 3/8-24 X 1/2"  12070054
1  ASSY, PROBE TOP, BORESCOPE 12 PIN CONNECTOR W/ SS THREADS  52070019
Appendix A: Filtering AquaLITE Data for further Analysis

Once data has been gathered and tracked through AquaLITE and the sampling event has concluded, it becomes tedious to manipulate and “clean-up” outliers within AquaLITE. This Appendix will outline how to export data from AquaLITE and then use a prepared template to import data into MS Excel. The excel template will generate a similar graph to the AquaLITE graph and will enable the user to filter outlier data points.

Steps:

1. From an active AquaLITE project, go to File > Export Log Data. “Save As” the log data (file type .log) to a known location.

2. Within the Windows Start menu navigate to the Geotech folder and select “Open new DATA TEMPLATE”. Once opened, make sure ‘macros’ are enabled by selecting “Enable Content”.

   - The excel template is stored in the location where AquaLITE is installed. This is usually in “C:\Program Files (x86)\Geotech\AquaLITE v8.3”.

3. Within the Data Template, Click on “Begin Data Input & Save File”. You will be prompted to select the “.log” file in the “USER Search for .log file to Import” window. Find the .log file exported from AquaLITE. Once selected, click on “Import File”
4. At this point, you will be prompted with a dialog window to input information on the well:

- Enter the name of the well
- Enter Depth of well.
- Select unit of depth, either feet or meters.
- Enter Magnetic Declination in degrees.

![Dialog Window]

5. As part of the import process, Excel saves your file as “[Well Name].xls” to the location of the .log file.

- You are ready to begin filtering the field data.

6. In the Data Template, notice that there are two sheet tabs in the bottom left of the window, “Data” and “Graph.”

- The graph on tab 2 should be very similar to the one generated by AquaLITE. As points/matches are filtered, it will adjust and clarify the data.

7. Column E, “# Points,” captures how many particle matches AquaLITE noticed and tracked per particle. It is helpful to filter these and show only particles that were matched, for example, 10 instances versus only 2 or 5. There is a small down arrow on this column header where you can manage the filter.
• Select and deselect # Points from the filter dialog box. Click “OK.”

• Example: for a data set of 1000 or more points, you can confidently discard data points that had less than 10 matches.

8. Adjust filter as necessary, referring to the updated graph on sheet 2 of the excel spreadsheet. Depending on the integrity of your data set, the graph should be cleaner with fewer outliers.

For further questions, please consult with your Geotech Technical Sales Representative.
<table>
<thead>
<tr>
<th>EDCF#</th>
<th>DESCRIPTION</th>
<th>REV/DATE</th>
</tr>
</thead>
<tbody>
<tr>
<td>-</td>
<td>Previous Release</td>
<td>11/04/2014</td>
</tr>
<tr>
<td>Project 1194</td>
<td>Updated Manual, SP</td>
<td>6/25/2015</td>
</tr>
<tr>
<td>Project 1480</td>
<td>Updated Accessories, added office test settings, SP</td>
<td>7/17/2015</td>
</tr>
<tr>
<td>Project 1480</td>
<td>Updated Troubleshooting and Software Installation, changed title to “Geotech Colloidal Borescope”, updated specifications - StellaR</td>
<td>9/28/2018</td>
</tr>
<tr>
<td>Project 1480</td>
<td>Removed PCMCIA from user manual – StellaR</td>
<td>11/1/2018</td>
</tr>
<tr>
<td>Project 1480</td>
<td>Changed image on pg 16, TA</td>
<td>1/1/19</td>
</tr>
<tr>
<td>Project #1763</td>
<td>Updated software installation and uninstallations instructions. Updated images according to updated software. Updated instructions for importing excel template – StellaR</td>
<td>6/18/2019</td>
</tr>
<tr>
<td>Project #1763</td>
<td>Modified figure 1-2 to include probe connector. Modified part list – StellaR</td>
<td>8/13/2019</td>
</tr>
<tr>
<td>Project #1836</td>
<td>Added note to not over tighten threads, to align pins on connector correctly. Added part numbers for protector cap and video card cable – StellaR</td>
<td>10/1/2019</td>
</tr>
<tr>
<td>Project #1836</td>
<td>Added PN 52070019, StellaR</td>
<td>10/14/2019</td>
</tr>
<tr>
<td>Project #1917</td>
<td>Modified description for 12070069, added PN 12070071. Corrected minor typos – StellaR</td>
<td>1/13/2020</td>
</tr>
<tr>
<td>Project #1989</td>
<td>Changed cable specification .32”OD to .375”OD – StellaR</td>
<td>5/26/2020</td>
</tr>
</tbody>
</table>
The Warranty

For a period of one (1) year from date of first sale, product is warranted to be free from defects in materials and workmanship. Geotech agrees to repair or replace, at Geotech’s option, the portion proving defective, or at our option to refund the purchase price thereof. Geotech will have no warranty obligation if the product is subjected to abnormal operating conditions, accident, abuse, misuse, unauthorized modification, alteration, repair, or replacement of wear parts. User assumes all other risk, if any, including the risk of injury, loss, or damage, direct or consequential, arising out of the use, misuse, or inability to use this product. User agrees to use, maintain and install product in accordance with recommendations and instructions. User is responsible for transportation charges connected to the repair or replacement of product under this warranty.

Equipment Return Policy

A Return Material Authorization number (RMA #) is required prior to return of any equipment to our facilities, please call our 800 number for appropriate location. An RMA # will be issued upon receipt of your request to return equipment, which should include reasons for the return. Your return shipment to us must have this RMA # clearly marked on the outside of the package. Proof of date of purchase is required for processing of all warranty requests.

This policy applies to both equipment sales and repair orders.

FOR A RETURN MATERIAL AUTHORIZATION, PLEASE CALL OUR SERVICE DEPARTMENT AT 1-800-833-7958.

Model Number: ________________
Serial Number: ________________
Date of Purchase: _______________

Equipment Decontamination

Prior to return, all equipment must be thoroughly cleaned and decontaminated. Please make note on RMA form, the use of equipment, contaminants equipment was exposed to, and decontamination solutions/methods used. Geotech reserves the right to refuse any equipment not properly decontaminated. Geotech may also choose to decontaminate the equipment for a fee, which will be applied to the repair order invoice.